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I. ATTACHMENT E

ACCESSING THE FCC NETWORK
USING WINDOWS 95/98

This attachment describes how to access the FCC Network from a system that is running the Microsoft
Windows 95 or Microsoft Windows 98 operating system.  This involves configuring dial-up network
access and then performing the dial-up procedure.

This attachment describes two methods to establish a remote connection to the FCC Network for both
the Mock Auction and Auction 80:

• The section titled Quick-Start Method for Connecting to the FCC Network describes a quick-start
approach, which uses standard default values to configure the dial-up networking software.

• If you need something other than the standard defaults, you can use the more complete method for
configuring and starting the dial-up software that is described under Complete Method for
Connecting to the FCC Network. 

This attachment also provides sections describing Troubleshooting and Help. 

Conventions

The instructions in this section use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions  link,
Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Applicant field, Selected Licenses
area of a screen).

bold italic Represents characters that you must type exactly as they appear in the      instructions. 
For example, if you are instructed to type http://wtbwww03.fcc.gov, you should type
all of the characters shown in bold italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note:  Throughout these instructions, “enter” means to type the appropriate information and then press
the ENTER key.
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A. Quick-Start Method for Connecting to the FCC Network

Following are quick-start procedures to establish a remote connection to the FCC Network for both
the Mock Auction and Auction 80.

Important:  Disable any screen saver software before performing either of the following
procedures.

1. Quick-Start for Mock Auction

To establish a remote connection to the FCC Network, double-click the Mock 80 Dial-Up
Connection icon and then select Connect.  Alternatively, you may do the following:

1. Click the Windows 95/98 Start button.

2. Click the Programs  option.

3. On the Programs menu, click the FCC Remote Bidding Software  option.

4. Click Mock 80 Dial-Up Connection.

The system checks to ensure that your computer has all components necessary to establish a dial-up
connection.  If a required component is missing, the system invokes Windows to help you set up the
component. 

5. When the system has verified that all necessary components are present, a dialog appears with
instructions on how to establish the dial-up connection.  Read these instructions, then click the OK
button.

6. When the dial-up connection window appears, click Connect to connect to the FCC Network.

Note that the system has also placed an icon labeled Mock 80 Dial-Up Connection on your desktop.
 To establish a dial-up connection in the future, you can double-click this icon instead of performing the
preceding steps.

2. Quick-Start for FCC Auction 80

Note: If you connect to the FCC’s 900# telephone service, there is a charge of $2.30 per
minute.  The first minute of connection time to the 900 number service is at no charge.

To establish a remote connection to the FCC Network, double-click the Auction 80 Dial-Up
Connection icon and then select Connect.  Alternatively, you may do the following:

1. Click the Windows 95/98 Start button.

2. Click the Programs  option.
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3. On the Programs menu, click the FCC Remote Bidding Software  option.

4. Click Auction 80 Dial-Up Connection.

The system checks to ensure that your computer has all components necessary to establish a dial-up
connection.  If a required component is missing, the system invokes Windows to help you set up the
component. 

5. When the system has verified that all necessary components are present, a dialog appears with
instructions on how to establish the dial-up connection.  Read these instructions, then click the OK
button.

6. When the dial-up connection window appears, click Connect to connect to the FCC Network.

Note that the system has also placed an icon labeled Auction 80 Dial-Up Connection on your
desktop.  To establish a dial-up connection in the future, you can double-click this icon instead of
performing the preceding steps.

3. If You Have Trouble Establishing the Connection

If you are have trouble making the connection, two things may have to be changed:

• The connection automatically precedes the phone number that is to be dialed with 9.  If you need a
digit other than 9 to reach an outside line, or no digit is needed, you will need to change the settings
in the connection.

To make this change, double-click the connection icon, then click Dial Properties.  You will see
that 9 precedes the phone numbers on all calls, both local and long-distance.  Change this digit to
what you need to get an outside line, or delete the 9, if appropriate.  Then click OK.

• The connection is set up for a standard 56K modem.  If you are using some other kind of modem,
you must change this setting.

To access dial-up networking:

1. Click the Windows 95/98 Start button.

2. Click the Programs  option.

3. On the Programs menu, click the Accessories option.

4. In Windows 95, click Dial-Up Networking.  In Windows 98, click Communications ,
then Dial-Up Networking.
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5. When you see the icon for dial-up networking that was created for you, right-click it and
select Properties. 

You will be in the General tab and you will see the standard default modem selected.

6. Select your modem from the drop-down menu and then click OK.

B. Complete Method for Connecting to the FCC Network

This section describes how to configure both the FCC Mock Bidding Software and the FCC Remote
Bidding Software for dial-up networking.  Then it describes how to use the configured software to
establish a connection to the FCC Network.

1. Configuring Dial-Up Networking

Important:  Disable any screen saver software before performing the following procedure.

1. To start dial-up networking:

a. Click the Windows 95/98 Start button. 
b. Click the Programs  option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d. In Windows 95, click Dial-Up Networking.

In Windows 98, click Communications , then Dial-Up Networking.

If Dial-Up Networking is not an option on your Accessories menu, you should install it from
your Windows 95/98 CD or diskettes.

2. When the Dial-Up Networking window appears, double-click the Make New Connection
icon.

The Make New Connection window appears.

3. If you are connecting to the FCC Network during the Mock Auction, type FCC Auctions
800# in the field titled Type a name for the computer you are dialing.

If you are connecting to test your connection on the 900# that will be used during Auction 80,
type FCC Auctions 900# in the field titled Type a name for the computer you are dialing.

Note: If you connect to the FCC’s 900# telephone service, there is a charge of $2.30
per minute.  The first minute of connection time to the 900 number service is at no
charge.

4. In Windows 95, click the down arrow at the right of the Select a modem field and select your
modem from the menu of available modems. 
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In Windows 98, click the down arrow at the right of the Select a device field and select your
modem from the menu of available devices.

If your modem does not appear on this list, you must install your modem driver according to the
modem manufacturer installation procedures, which are usually described in your modem’s user
manual.

5. Click the Next button. 

6. If you are connecting to the FCC Network during the Mock Auction, type 800 and 378-7435
in the Area Code and Telephone Number fields, respectively. 

If you wish to test your connection on the 900# that will be used during Auction 80, type 900
and 555-5335 in the Area Code and Telephone Number fields, respectively.

7. Verify that the correct country is selected in the Country code field. 

If necessary, click the down arrow at the right of the Country code field and select the
appropriate country from the menu of available countries.

8. Click the Next button.

9. Click the Finish button. 

An icon labeled either FCC Auctions 800# or FCC Auctions 900# appears in the Dial-Up
Networking window.

10. Verify that properties are configured correctly before attempting a dial-up session.  Put the
mouse pointer on the FCC Auctions icon that you wish to configure and click the right mouse
button to display a menu.  Click Properties from the menu.

11. Click the Configure  button.  Click the Options  tab at the top of the Properties window.

12. In the Connection control area of the Options tab, verify that neither option is selected.  If
either option is selected, click the check box at the left of the option to deselect it.  Then click
OK.

13. In Windows 95, click the Server Type... button.

In Windows 98, click the Server Types tab at the top of the Properties window.

14. In the Advanced Options area, verify that only Enable software compression  is selected. 

If it is not selected, click the check box at the left of the option to select it.  If either of the other
options is selected, click the check box to deselect it.
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15. In the Allowed Network Protocols area, verify that only TCP/IP is selected. 

If it is not selected, click the check box at the left of the option to select it.  If either of the other
options is selected, click the check box to deselect it.

16. Click the TCP/IP Settings button and select Specify name server addresses.

17. Type 165.135.241.149 as the Primary DNS and 165.135.79.95 as the Secondary DNS.

18. At the bottom of the TCP/IP Settings window, ensure that Use IP Header Compression and
Use Default Gateway on the Remote Network options are selected.

19. Click OK on the TCP/IP Settings window and the Server Type window.

20. a.  Click the Windows 95/98 Start button, then click the Settings option to display
                 the Settings menu.

b.   Click Control Panel and then double-click the Network icon.

c. Highlight the TCP/IP Protocol and click Properties.  If there are multiple TCP/IP
protocols, highlight TCP/IP --> Dial-Up Adapter and click Properties.

d.   Click the DNS Configuration tab.

e. Type bidder in the Host box and type fcc.gov in the Domain box.

Note:  You are limited to three DNS entries. If you already have three DNS entries, you
must delete two of them before performing the next two steps.  To do this, click the first
entry you want to delete and click the Remove button.  Then click the second entry you
want to delete and click the Remove button again.

f. Type 165.135.241.149 in the DNS Server Search Order box and click the Add button.

g. Type 165.135.79.95 in the DNS Server Search Order box and click Add again.

h. Click OK on the TCP/IP Properties windows, then click OK on the Network
      windows.

 If you are prompted to restart your computer, click Yes to restart, then begin
the Dial-Up Procedure.

2. Dial-Up Procedure

1. If the Dial-Up Networking window is not currently open, do the following:

a. Click the Windows 95/98 Start button. 
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b. Click the Programs  option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d. In Windows 95, click Dial-Up Networking

In Windows 98, click Communications , then Dial-Up Networking. 

The Dial-Up Networking window appears. 

2. In the Dial-Up Networking window:

Double-click the FCC Auctions 800# icon if you wish to connect to the FCC Network during
the Mock Auction.

Double-click on the FCC Auctions 900# icon if you wish to test your connection to the 900#
that will be used during Auction 80.

Note: If you connect to the FCC’s 900 number telephone service, there is a charge of $2.30
per minute.  The first minute of connection time to the 900 number service is at no charge.

3. Click the Connect button on the window.  Do not enter User name or Password.

The Connection window appears, indicating the status of your connection as your modem dials
into the system.  This window must remain running during your dial-up session.  You may
minimize the window, if you wish.

If your modem fails to establish a connection, please see the Troubleshooting section below.

4. Once the connection is established, double-click the Auction 80 Mock Auction Software  or
Auction 80 Bidding Software  icon.

5. When you have finished, exit the mock or auction software, then click the Disconnect button
on the Connection window to end your dial-up session.

C. Removing the Dial-Up Networking Service

Once you have finished using the dial-up networking service, you can remove it from your computer, as
follows:

1. Click the Windows 95/98 Start button, then click the Settings option to display the Settings menu.

2. Click Control Panel and then double-click the Network icon.

3. Highlight the TCP/IP Protocol and click Properties.  If there are multiple TCP/IP protocols,
highlight TCP/IP --> Dial-Up Adapter and click Properties.

In a Windows 98 environment, a confirmation dialog appears.  Read the information on the dialog,
then click the OK button.
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4. Click the DNS Configuration tab.

5. Click the DNS Server Search Order box containing 165.135.241.149 to select it, then click the
Remove button.

6. Similarly, click the DNS Server Search Order box containing 165.135.79.95 to select it, then click
the Remove button.

7. Click OK on the TCP/IP Properties windows, then click OK on the Network windows.

8. If you are prompted to restart your computer, click Yes to restart.

9. Remove the FCC Auctions 800# icon from your desktop.  That is, click the icon with your right
mouse button and then click the Delete  option in the pull-down menu.

D. Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating them.

1. Modem does not respond

1. Confirm that all physical connections for the modem are present.

2. Confirm that the phone line is active by connecting it to a telephone and checking for a dial tone.

3. If you are dialing the 900 number service, check for a 900 number telephone block.  If the
volume settings are low, the modem may be dialing but not connecting.  Check for this by trying
to connect to the 800 number, or by dialing the 900 number on that line using a telephone.

4. Confirm that the correct modem driver is installed for your modem.

2. Modem dials but does not connect

1. If you are dialing the 900 number service, check for a 900 number telephone block.  Check for
this by dialing the 800 number to see if you connect, or by dialing the 900 number on that line
using a telephone.

2. Confirm that the number the modem is dialing is correct.

3. Confirm that the modem prefix, if any, is correct.



E-9

3. Modem dials and connects, but nothing appears when you enter the Location in the
Web browser 

1. Verify the Dial-Up Networking settings specified in the Configuring Dial-Up Networking
section.

2. Confirm that your Web browser is not using proxies.   

a) On your browser, click the Preferences option in the Edit menu.
b) In the Category area at the left, double-click Advanced.
c) Click the Advanced structure’s Proxies option.
d) Click the radio button labeled Direct connection to the Internet.
e) Click the OK button at the bottom of the window.

4. Receive an Internal Server error in the Web browser

1. Confirm that the Location is correct.

2. Confirm that Java and JavaScript are enabled in your Web browser, and confirm that Cookies is
set to Accept All.

E. Help

For technical assistance with installing or using FCC software, contact the FCC Technical Support
Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY).  The FCC Technical Support Hotline is
generally available Monday through Friday from 7 a.m. to 10 p.m. ET, Saturday from 8 a.m. to 7 p.m.
ET, and Sunday from 12 p.m. to 6 p.m. ET.  All calls to the FCC Technical Support Hotline are
recorded.


